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[bookmark: _heading=h.30j0zll]Preface
Licensing ■ About Quest Software, Inc. 


JClass ServerChart Designer provides a graphical interface for creating a JClass ServerChart in XML. You can create any of the charts and use all of the features described in Part I of the JClass ServerChart Programmer’s Guide. For more information on using XML with JClass ServerChart, see the chapter called “Loading and Saving Charts Using XML” in the JClass ServerChart Programmer’s Guide. JClass ServerChart Designer is installed by default when you install JClass ServerChart.
[bookmark: _heading=h.1fob9te]Licensing
In order to use JClass ServerChart Designer, you need a valid license. Complete details about licensing are outlined in the JClass ServerViews Installation Guide, which is automatically installed when you install JClass ServerChart.

[bookmark: _heading=h.2et92p0]About Quest Software, Inc.
Quest Software (now a part of Dell) simplifies and reduces the cost of managing IT for more than 100,000 customers worldwide. Our innovative solutions make solving the toughest IT management problems easier, enabling customers to save time and money across physical, virtual and cloud environments. For more information about Quest go to www.quest.com. 

[bookmark: _heading=h.3dy6vkm]Contacting Quest Software

	Email
	info@quest.com

	

Mail
	Quest Software, Inc. World Headquarters 5 Polaris Way
Aliso Viejo, CA 92656 USA

	Web site
	www.quest.com



See our web site for regional and international office information.
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[bookmark: _heading=h.1t3h5sf]
Contacting Quest Support 
Quest Support is available to customers who have a trial version of a Quest product or who have purchased a Quest product and have a valid maintenance contract. Quest Support provides unlimited 24x7 access to Support Portal at http://support.quest.com. 
From our Support Portal, you can do the following: 
· Retrieve thousands of solutions from our online Knowledgebase
· Download the latest releases and service packs
· Create, update and review Support cases 
View the Global Support Guide for a detailed explanation of support programs, online services, contact information, policies and procedures. The guide is available at: http://support.quest.com. 
Quest Communities 
Get the latest product information, find helpful resources, and join a discussion with the JClass Quest team and other community members. Join the JClass community at http://jclass.inside.quest.com/.
[bookmark: _heading=h.4d34og8][bookmark: bookmark=id.2s8eyo1]1
JClass ServerChart Designer Basics

Launching JClass ServerChart Designer
Introduction to the JClass ServerChart Designer Interface ■ The Menu Items
Creating a Basic ServerChart ■ Common JClass ServerChart Designer Procedures


JClass ServerChart Designer is an application that helps you generate tags for XML output through a GUI. You are able to create charts using a WYSIWYG interface. When you save a chart, its properties are saved as XML tags in an XML file.

[bookmark: _heading=h.3rdcrjn]1.1 	Launching JClass ServerChart Designer
To launch JClass ServerChart Designer, double-click the jcschart-designer.bat or jcschart-designer.sh file, located in your JCLASS_SERVER_HOME/bin directory. The JClass ServerChart Designer splash screen appears. Note: In Windows, you can select JClass ServerChart Designer from the Start Menu. 
The Welcome Window
When you launch JClass ServerChart Designer, the Welcome window opens by default. You can choose to open an existing file, create a new chart, or continue working on the last file that was open.
[image: ]
Figure 1	The Welcome window.

If you select the Do not show this dialog again check box, the Welcome window is not displayed the next time you start JClass ServerChart Designer. You can restore the default behavior by editing your preferences. For more information, see “Selecting Visible Windows” in Section 1.3.3, Setting your Preferences.

The Chart Palette Window
The Chart Palette window simplifies the process of designing a new chart. To design a new chart, you click the image that represents the type of chart that you want to create. JClass ServerChart Designer creates the chart and configures some of the properties for you, saving you time and effort. As you design your own charts, you can add them to the Chart Palette window. For more information, see Section 1.3.2, Adding a Custom Chart to the Chart Palette.

[image: ]
Figure 2	The Chart Palette window.

If you select the Do Not Show this Screen in Future check box, the Chart Palette window is not displayed the next time you create a new chart. You can restore the default behavior by editing your preferences. For more information, see “Selecting Visible Windows” in Section 1.3.3, Setting Your Preferences.


[bookmark: _heading=h.lnxbz9]1.2 	Introduction to the JClass ServerChart Designer Interface
	The JClass ServerChart Designer interface has three major sections: 
· The View, which displays the currently designed chart. You can use this area to resize objects by dragging the grab handles that appear when an object is selected.
· The Chart Objects list, which lists the different elements of a chart that can be customized. From this list you can select an item to display its properties for editing.
· The Properties Editor, which provides all the different attributes that can be edited for the currently selected item in the Chart Objects list.
[image: ]
Figure 3	The JClass ServerChart Designer Interface

[bookmark: _heading=h.1ksv4uv]1.3 	The Menu Items

JClass ServerChart Designer’s interface has a File and a Help menu. Each menu is used to perform different tasks; the following is a summary of what you can do using the items in these menus. 
1.3.1	The File Menu 
The File menu is your basic starting point for JClass ServerChart Designer. This menu enables you open files, create new charts, and save your changes.

The following procedures can be performed through the File menu:

	File Menu

	· Creating a New Chart
· Opening a Chart
· Saving a Chart




Creating a New Chart 
To create a new chart, select New Chart from the File menu. 

Note: If you already have a file opened in JClass ServerChart Designer with unsaved changes, you are prompted to save the current document.
Opening a Chart
If the file you want to open appears in the File menu’s history list, select it from that list. Otherwise, you can navigate to find the file. 
1. From the File menu, select Open. The Open window appears.
2. In the Open window, navigate to the location of the file you want to open. 
3. Either double-click the file name in the Open window, or highlight it and click the Open button.
Saving a Chart
1. From the File menu, select Save. If the document has not been saved before, the Save window appears. If it has previously been saved, this updates the saved file.
2. If the Save window appears, enter a name for the file in the File Name text box.
3. Navigate to the location where you want to save the file. 
4. Click the Save button. To create a new chart, select New Chart from the File menu. 

[bookmark: _heading=h.44sinio]Note: If you already have a file opened in JClass ServerChart Designer with unsaved changes, you are prompted to save the current document. Note: If you already have a file open in JClass ServerChart Designer with unsaved changes, you are prompted to save the current document.

1.3.2	Adding a Custom Chart ot the Chart Palette 

A chart can be added to the Custom section in the Chart Palette by selecting the Save to Palette option from the File menu. In the resulting window, enter a unique name for the chart and click the OK button. 

Note: Right-clicking on individual buttons of the chart palette brings up a menu that allows for a chart to be selected from the palette for creation, for setting as the new default chart, or for deletion (only custom types can be deleted).

1.3.3	Setting Your Preferences 

JClass ServerChart Designer allows you to customize your preferred home directory, import these settings from a file, and export the settings to a file. This allows you to save your preferences outside of the system variables for future use. 

To open the Edit Preferences window, select Preferences from the File menu.

[image: ]
Figure 4	The Edit Preferences window.

Choosing a Home Directory
The home directory identifies which directory is used as JClass ServerChart Designer’s default directory.
1. To set your home directory, click Select beside the Home Directory field. 
2. In the Choose Home Directory window, navigate to and select the directory you want to set as your home directory, and click Choose Home Directory.
3. Click Apply.
Selecting Visible Windows
The Welcome window and the Chart Palette can be turned on or off by selecting or deselecting the appropriate check box in the Show section. Click Apply.
Importing from a File and Exporting to a File
Preferences are saved in your system variables. JClass ServerChart Designer allows you to import a file containing information about saved preferences to update the current profile, or to export your preferences to a file for future use.
· To import preferences from a file, click Select beside the Import Preferences From File field. In the Open window, navigate to and select the file you want to import, and click Open. Click Apply.
· To export preferences to a file, click Select beside the Export Preferences From File field. In the Save window, navigate to and select the location where you want to export the file, provide a file name, and click Save. Click Apply.

1.3.4	The Help Menu 
The Help menu is your gateway to the JClass ServerChart Designer help, as well as to the JClass ServerChart Designer’s About window. To access either feature, select it from the Help menu list.
[bookmark: _heading=h.2jxsxqh]1.4	Creating a Basic ServerChart
JClass ServerChart Designer allows you to create the basic properties for a chart. Though it is not necessary for you to follow these steps, in general this is what you need to do to create a chart.

	Step
	See

	1. Set general chart properties
2. Customize the chart area.
3. Set the plot area properties.
4. Define axes properties.
5. Determine the data view and set its properties.
6. Customize the chart’s header and footer.
7. Customize the chart’s legend.
8. Set the properties for the chart labels.
	The Chart Properties Editor
The Chart Area Properties Editor
The Plot Area Properties Editor
The Axes Properties Editor
The Data view Properties Editor

The Header and Footer Properties Editors
The Legend Properties Editor
The Chart Labels Properties Editor



[bookmark: _heading=h.z337ya]1.5	Common JClass ServerChart Designer Procedures
Several properties are common to more than one chart object. Though they customize different elements on a chart, the procedures for customizing these properties do not change, regardless of which chart object you are editing.

	Procedure
	Chart Object

	Setting Colors
	Chart, Chart Area, Plot Area, Chart Header, Chart Footer, and Chart Legend Properties Editors, Axis Title

	Setting a Fill Style
	Data View (Chart Style, Outline Style, Hole Style, Threshold), Chart Area, and Legend Property Editors

	Setting a Line Style
	Data View Property Editor (Chart Style, Hole Style, Outline Style, Marker, Threshold)

	Setting a Symbol Style
	Data View Property Editor (Chart Style, Hole Style)

	Selecting a Font
	Chart Area, Chart Header, Chart Footer, and Chart Legend Properties Editors, Axis Annotation Axis Title






	Procedure
	Chart Object

	Setting Borders
	Chart, Chart Area, Chart Header, Chart Footer, and Chart Legend Properties Editors

	Setting the Location and Dimensions
	Chart Area, Chart Header, Chart Footer, Chart Legend Properties, and Axis Title Editors

	Setting the Image Map
	Chart, Chart Area, Plot Area, Data View, Chart Header, Chart Footer, and Chart Legend Properties Editors



1.5.1	Setting Colors 
Wherever you see a Color, Background, Foreground, or Fill Color field, you can change the colors used for the corresponding element. For background colors, if you want the color to be visible, you need to select the adjacent Opaque check box. All other colors are automatically opaque.

[image: ]
Figure 5	Selecting a color.

To change the color of any chart element, you can either type the Java color name or RGB value into the text field, or click the Select button to change the color using the Choose a Color window. The RGB value is a series of three numbers, separated by a hyphen, none of which exceed 255. For example, 205-5-62 is a valid RGB value. 
Note: The color name or RGB value automatically appears in the text field when a color has been selected. 
1. To select a color from the Choose a Color window, click Select next to the color field.
2. There are three ways to choose a color:
· Select the Swatches tab to choose a color from a standard series of color swatches. From the display, click on the color of your choice. Note that previous color selections appear in the Recent swatches.

[image: ]
			Figure 6	The Swatches tab in the Choose a Color window.

· Select the HSB tab to choose a color by hue, saturation or brightness. To adjust colors one property at a time, select either the radio button next to H to select a color by hue, next to S to select a color by saturation, or next to B to select a color by brightness. You can either click inside the color box to select a color or drag the arrow next to the color bar to adjust it. At all times, you can click the arrows next to the HSB values to increase or decrease their value, or enter in a number to replace the value. Note that the RGB values of the color you are displaying appear in the RGB boxes beside the color bar.

[image: ]
			Figure 7	The HSB tab in the Choose a Color window.



· Select the RGB tab to choose a color based on its red, green, and blue values. To do so, you can either input the color values into the text boxes associated with each color, click the arrows next to the associated values to increase or decrease the color value, or drag the associated arrows to the left or right to decrease or increase the amount of the associated color in the overall selected shade.

[image: ]
Figure 8	The RGB tab in the Choose a Color window.
Note: Regardless of which tab you use to choose a color, there is a Preview section at the bottom of the Choose a Color window that displays the color that is currently selected. This allows you to see what the color looks like next to black, white, or grey, as well as what text in that color looks like over white and grey, and what black text looks like over the color.
3.    To commit your color selection, click the OK button. 

If at any time you want to return to color that was selected when you opened the Choose a Color window, click the Reset button. To exit the Choose a Color window at any time without committing your selection, click the Cancel button.



1.5.2	Setting a Fill Style
Fill styles control the way that an object is filled. You can fill the background with a solid color, a pattern, an image, or a gradient fill. 

To add or edit a fill style: 

1. If the component is transparent (such as the Chart, Chart Area, or Legend), the Fill Style tab is inactive. You first need to select the Opaque check box in the Colors area of the appropriate property editor as described in Section 1.5.1, Setting Colors.

The Fill Style tab becomes available to select.

2. Select the Fill Style tab.

The fill style currently designed is displayed in the Preview area. If no fill style has been specified, the default fill pattern (Solid) is displayed. 

[image: ]
Figure 9	Fill Style with default Solid pattern.

3. You can select a pattern, gradient paint, or an image. Make sure your selection from the Pattern drop-down list. 
4. If you selected one of the patterns fromt eh Pattern drop-down list, the pattern is displayed in the Preview area. You can change the colors in the Fill Color and Background fields. For more information, see Section 1.5.1, Setting Colors.
[image: ] 
Figure 10	Fill Style with a basic pattern selected.



5. If you selected Gradient Paint from the Pattern drop-down list, a default gradient is displayed in the Preview area. 
· To customize the colors, select colors in the Color 1 and Color 2 fields. For more information, see Section 1.5.1, Setting Colors. 
· To can change the style of the gradient, select a new style from the Gradient Style drop-down list. The Preview changes to display the selected gradient. 
· If the gradient style is a ribbon, you can change the width of the ribbon in the Ribbon Size field.

[image: ]
Figure 11 	Fill Style with a gradient paint selected.

6. If you selected Image or Stacked Image from the Pattern drop-down list, the Image tab becomes available. Select the Image tab.
[image: ]
Figure 12	 Fill Style with an image selected.

· If the image is available locally, you can preview the appearance if the image. To do so, use the Local Image File field to enter the path and file name of the fill image, or click the Select... button to navigate to it. 
· To specify where the image is anchored within the container, select an anchor point from the Fill Orientation drop-down list. If you select Absolute, enter the X and Y coordinates in the Image Position area. Specifying an absolute position of 0,0 is equivalent to selecting Top Left from the drop-down list. 
· To specify whether the image is tiled, scaled, or used as-is, select a style from the Image Layout Hints drop-down list. 
· To specify the image that will be referenced in the XML file that is generated by JClass ServerChart Designer, enter a name, relative file, absolute path, or URL for the file in the Image File Access String field. Then select the access type from the Access Type drop-down list. The access type specifies how to access the specified image file on the server at runtime. For more information, see “LoadServerProperties Class and the fileAccess Property” in the “Using JCServerChartFactory” chapter of the JClass ServerChart Programmer’s Guide.

1.5.3	Setting a Line Style 
The line style determines the appearance of the lines in the chart.

[image: ]
Figure 13	 Line Style fields. 
To edit the line style
1. Select the Line Style tab (if available). 
Note: The line style fields may appear on other tabs, such as the Grid tab of the Axes property editor.
The line style currently designed is displayed in the Preview area.
2. Select a line color in the Color field. See Section 1.5.1, Setting Colors.
3. In the Width field, type a value for the width of the line (in pixels) or select a value using the spinbox arrows.
4. To set the style to use for the line, select a line style from the Style drop-down list.
5. To specify how two lines are joined, select a join style from the Join drop-down list.
6. To specify how the end of a line should look, select a cap style from the Cap drop-down list.


1.5.4	Setting a Symbol Style 
The appearance of symbols can be customized.

[image: ]
Figure 14	Symbol Style fields.
To customize a symbol: 
1. Select the Symbol Style tab.
The symbol style currently designed is displayed in the Preview area.
2. To set the color of a symbol, select it in the Color field. For more information, see Section 1.5.1, Setting Colors.
3. In the Size field, either enter a (in pixels) or use the up and down arrows to determine the symbol size. 
4. To change the shape, select a shape from the Shape drop-down list.



1.5.5	Selecting a Font 
Whenever you see the font section, you are able to set the font property for the corresponding element. The fonts that you are able to select from are those that are available on your system. You can see a preview of the font beside the Select button.

[image: ]
Figure 15	Font section.

1. To select a font, click the Select button to open the Font Chooser window.
[image: ]
2. In the Font Chooser window, select the font you want to use from the Font list.

Note: All fonts that are available on your system appear in the Font list.

3. To change the font size, either select a font size in the Size list, or type a value in the field. Font sizes must be positive integers.

Note: If you enter a font size value that produces a very large font, it may not appear on the chart.

4. To apply font styles, such as bold or italic, select the corresponding check box in the Style section. 

5. To commit your font selection, click the OK button. 

If at any time you want to return to the font that was selected when you opened the Font Chooser window, click the Reset button. To exit the Font Chooser window at any time without committing your selection, click the Cancel button.

1.5.6	Setting Borders 

Whenever you see the border section, you are able to set the border properties for the corresponding element. Depending on the border type you have selected, you have different properties available for customization. The following describes all of the different options.

Empty Border

[image: ]
Figure 16	Empty Border properties.

1. From the Border drop-down list, select Empty.

2. Define the Top, Left, Bottom, and Right margins either by entering a value in the corresponding field or by using the up and down arrows.

Bevel Border or Soft Bevel Border
[image: ]
Figure 17	Bevel and Soft Bevel Border properties.

1. From the Border drop-down list, select Bevel or Soft Bevel.
2. Select either the Lowered or Raised radio button to determine the appearance of the border.
Lowered makes the element appear sunken into the background; Raised makes it appear elevated from the background.
3. Select colors for the Highlight and the Shadow of the border, in their respective fields. For more information about choosing colors, see Section 1.5.1, Setting Colors.



Etched Border
[image: ]
Figure 18	Etched Border Properties

1. From the Border drop-down list, select Etched.
2. Select either the Lowered or Raised radio button to determine the appearance of the border.
Lowered makes the element appear sunken into the background; Raised makes it appear elevated from the background.
3. Select colors for the Highlight and the Shadow of the border, in their respective fields. For more information about choosing colors, see Section 1.5.1, Setting Colors.

Line Border
[image: ]
Figure 19	Line Border Properties

1. From the Border drop-down list, select Line.
2. Select a Line Color. For more information about choosing colors, see Section 1.5.1, Setting Colors.
3. In the Line Thickness field, either enter a value or use the up and down arrows to determine the width of the border. For rounded corners, select the Rounded Corners check box.



Matte Border
[image: ]
Figure 20	Matte Border Properties
1. From the Border drop-down list, select Matte.
2. Define the Top, Left, Bottom, and Right margins either by entering a value in the corresponding field or by using the up and down arrows.
3. Select a border color. For more information about choosing colors, see Section 1.5.1, Setting Colors.

Titled Border
[image: ]
Figure 21	Titled Border Properties
1. From the Border drop-down list, select Titled.
2. In the Title Text field, type the text you want to use as the border’s title.
3. Use the Title Position drop-down list to determine the position of the title on the chart. Options are Default Position, Above Top, Top, Below Top, Above Bottom, Bottom, and Below Bottom.
4. From the Title Justification drop-down list, select the justification. Options are Default Justification, Left, Center, Right, Leading, and Trailing.
5. Select a font for the title text. For more information, see Section 1.5.5, Selecting a Font.
6. Determine the color of the text. For more information about choosing colors, see Section 1.5.1, Setting Colors.


1.5.7	Setting the Location and Dimensions 
The Locations area controls where an element appears and how big it is.	
[image: ]
Figure 22  Location section.
1. To set the location of the element, specify values in the X and Y fields. 0,0 sets the element in the top left corner.
2. To set the dimensions of the element, specify values in the Width and Height fields. 
Alternatively, select Default to have JClass ServerChart Designer place and size the element.

1.5.8	Setting the Image Map 
Image maps require a URL to link to, and are equipped to handle extra information to go into the image map tag.
[image: ]
Figure 23	ImageMap section.

To set the URL, enter the link in the URL field. To add extra information for the image map (for example, alt="JClass ServerChart Designer image"), enter it in the Extra field.


[bookmark: _heading=h.3j2qqm3]2
The Chart Properties

Defining Basic Chart Elements ■ Using Anti-Aliasing

The Chart properties editor allows you to customize very basic chart elements. It allows you to name a chart, set its dimensions, determine the colors used, and define a border, all without delving into XML code.

[image: ]
Figure 24	JClass ServerChart Designer’s Chart properties editor.


The following list outlines basic procedures that can be performed in the Chart properties editor:

	Procedures

	· Defining Basic Chart Elements

	· Using Anti-Aliasing

	· Setting the background and Foreground Colors for a Chart; see Section 1.5.1, Setting Colors.

	· Adding a Fill Style in the Background of the Chart; see Section 1.5.2, Setting a Fill Style.

	· Setting a Chart Border; see Section 1.5.6, Setting Borders.

	· Setting the Image Map; see Section 1.5.8, Setting the Image Map.



[bookmark: _heading=h.1y810tw]		2.1	Defining Basic Chart Elements
A chart’s basic elements are its name and size, as well as whether it is double buffered or batched. The chart name is an internal value; it is not displayed on the chart. 

1. To define the chart’s name, type the text string in the Name field.
2. If the chart is intended to be double buffered, select the Double Buffered check box. Normally, this property would be selected to speed up the drawing process.
3. If the chart is intended to be batched, select the Batched check box. If Batched is selected, then changes to the chart are accumulated and sent to display later on, rather than immediately. 
Note: The Batched property does not affect the View area of the JClass ServerChart Designer from updating immediately; it applies only to the generated chart.
4. Use the Width and Height fields to determine the dimensions of the chart. You can either type in values or use the up and down arrows to set the size.
[bookmark: _heading=h.4i7ojhp]2.2	Using Anti-Aliasing
Anti-aliasing is the process of smoothing out lines and curves to remove the pixelated appearance of text and graphics. To determine whether or not anti-aliasing is turned on, select the value from the Antialiasing drop-down list. Values are Default, On, or Off.


[bookmark: _heading=h.2xcytpi]3
The Chart Area Properties Editor

Defining Basic Chart Area Elements   ■   Setting the 3D View

The Chart Area properties editor controls the appearance of the chart area. It allows more precise control over the generated chart, setting the various different properties that affect that appearance of the chart area.
[image: ]
Figure 25	JClass ServerChart Designer’s Chart Area Properties editor.


The following procedures can be performed in the Chart Area properties editor:

	Procedures

	· Defining Basic Chart Area Elements

	· Setting the 3D View

	· Defining the Location; see Section 1.5.7, Setting the Location and Dimensions.

	· Selecting the Chart Font; see Section 1.5.5, Selecting a Font.

	· Setting the Colors for the Chart Area; see Section 1.5.1, Setting colors.

	· Adding a Fill Style to the Chart Area; see Section 1.5.2, Setting a Fill Style.

	· Setting a Chart Area Border; see Section 1.5.6, Setting Borders.
· Setting the Image Map; see Section 1.5.8, Setting the Image Map.



[bookmark: _heading=h.1ci93xb]3.1	Defining Basic Chart Area Elements
There are three elements that are determined by the basic chart area: the chart’s visibility, whether it is a fast action chart, and the unit of measurement used for angles. 

· To make the chart visible, select the Visible check box.
· To enable fast action, select the Fast Action check box.
If the Fast Action check box is selected, the chart uses an optimized mode in which it does not display axis annotations or gridlines.
· To select the unit of measurement for the angles of a chart, select it from the Angle Unit drop-down box. Options are Radians, Degrees, or Grads. Angle Unit tells JClass ServerChart how to interpret angle values that are set on the chart. 
Note: Any properties in JClass ServerChart Designer that are set using angles always use degrees. These values are converted by JClass ServerChart Designer to the corresponding value in the appropriate units.

[bookmark: _heading=h.3whwml4]3.2	Setting the 3D View
The 3D view of a chart determines the depth, elevation, and rotation of the chart, allowing it to appear in 3D. Only Bar, Stacking Bar, and Pie charts support 3D views. All other chart types do not allow you to edit the 3D View property. If you do not want your chart to appear in 3D, set the values to zero.

· To set up a 3D chart, either type in a value or use the up and down arrows to provide a value for the Depth, Elevation, and Rotation fields in the Chart Area properties editor.
[bookmark: _heading=h.2bn6wsx]4
The Plot Area Properties Editor

Setting the Plot Area Margins   ■   Using a Bounding Box

The appearance of the chart’s plot is determined by the values set in the Plot Area properties editor. Along with color, you can set values for margins and determine if there will be a bounding box around the plot’s boundary.

[image: ]
Figure 26	JClass ServerChart Designer’s Plot Area properties editor.

The following list outline basic procedures that can be performed in the Plot Area properties editor:

	Procedures

	· Setting the Plot Area Margins

	· Using a Bounding Box

	· Setting the Colors for the Plot Area; see Section 1.5.1, Setting Colors.

	· Setting the Image Map; see Section 1.5.8, Setting the Image Map.



[bookmark: _heading=h.qsh70q]4.1	Setting the Plot Area Margins
Margins can be set for the plot area to allow space between it and the remainder of the chart elements. To eliminate the margins, set the values to zero. 

Note: When the Default check box is selected, you cannot change the value of the corresponding field. For example, if the Default check box next to the Top field is selected, the top value cannot be changed. 

· Define the Top, Left, Bottom, and Right margins either by entering a value in the corresponding field or by using the up and down arrows.

[bookmark: _heading=h.3as4poj]4.2	Using a Bounding Box
You can further enhance the plot area’s boundary by placing a bounding box around it. The color of the bounding box is determined by the color set in the Foreground field. 

Note: Pie, Polar, Radar, and Area Radar charts do not support bounding boxes. If you are editing one of these chart types, the Axis Bounding Box check box is disabled. 

· To place a bounding box around the plot area’s boundary, select the Axis Bounding Box check box.


[bookmark: _heading=h.1pxezwc]5
The Axes Properties Editor

Adding and Deleting an Axis   ■   The General Tab   ■   The Annoation Tab
The Scale Tab   ■   The Title Tab   ■   The Grid Tab   ■   The Exclusions Tab



JClass ServerChart Designer allows you to edit the appearance of the chart axes through the Axes properties editor. 

Note: The Axis properties cannot be edited when creating pie charts, because pie charts do not have axes.

[image: ]
Figure 27	JClass ServerChart Designer’s Axes properties editor.



The Axes properties editor is composed of several different tabs: 
· General tab, which sets the basic axes properties, such as defining the axis relationship and axis placement.
· Annotation tab, which controls the appearance of any axis annotations.
· Scale tab, which defines size and placement.
· Title tab, which determines the appearance of the axis title.
· Grid tab, which defines grid properties.
· Exclusions tab, which defines periods of time during which data is not displayed. 

Aside from the different tabs available, there is also an Axes list on the left side of the Axes properties editor. The axis selected in the Axes list is the one that is currently being edited.

[image: ]
Figure 28	Axes list.
[bookmark: _heading=h.49x2ik5]5.1	 Adding and Deleting an Axis
There must always be at least one axis for both X and Y in the Axes list. When there is only one axis in the list for either X or Y, you will receive an error message if you attempt to delete it. 

Once an axis has been added, it needs to be mapped to a data view; otherwise, the axis is not bound to data. To directly map an axis to a data view, go to the Data View/Associated Axis editor and select the desired data view in the Data View listbox and desired axis in the Axes list. At that point, the axis is mapped and its scale is automatically updated. 

An axis can also be indirectly mapped to a data view by establishing an axis relationship. For more details, see Section 5.2.2, Defining Axis Relationships. 

Note: If an axis that is mapped to a data view is deleted, the data view is automatically set to the first corresponding X- or Y-axis in the Axes list. 

· To add an axis, click the [image: ] button; to eliminate an axis from the list, highlight it and click the [image: ] button.
[bookmark: _heading=h.2p2csry]5.2	The General Tab
The General tab allows you to edit general axis properties, as well as provides you with information regarding the orientation of the axis (horizontal or vertical).

[image: ]
Figure 29	Axes properties editor – General tab.

Any data views that are associated with the current axis are listed in the Data Views list; to edit the properties for a data view, select it in the list and click the Go to Data View Editor button. 

The following list outlines procedures that can be performed in the Axes’ General tab:

	Procedures

	· Setting Basic Properties

	· Defining Axis Relationships

	· Defining Axis Placement

	· Setting the Image Map; see Section 1.5.8, Setting the Image Map.



5.2.1	Setting Basic Properties
From the General tab, you can determine if the axis is visible and editable, if it is a logarithmic axis, or if the annotation of the axis should appear in reversed order. 

· To set any of the basic properties on the General tab, select the corresponding check box. 

Properties are Visible (to make the axis information visible), Editable (to allow the axis to be edited), Logarithmic (to set the axis to be interpreted logarithmically (log base 10)), and Reversed (to reverse the annotation on the axis).



5.2.2	Defining Axis Relationships

Axis relationships can only exist between axes of the same orientation. Therefore, if an X-axis is selected in the Axes list, only X-axes are available as originators; if a Y-axis is selected in the Axis list, only Y-axes are available as originators. 

Note: Polar, Radar, and Area Radar charts do not support multiple X- or Y-axes. When you are editing those chart types, you cannot define axis relationships. (The properties are grayed out.) 

If an axis relationship is specified, the axis specified in the Axis list is calculated from the specified related axis through the equation x1 = m(x2)+c, where x1 is a value along this axis, x2 is the value along the originating axis, m is the multiplier, and c is the constant. 

1. From the General tab, select an originator for the axis in the Originator drop-down list.
2. In the Multiplier field, enter a value. This is the m value in the axis relationship equation.
3. In the Constant field, enter a value. This is the c value in the axis relationship equation.
5.2.3	Defining Axis Placement 

Axis placement determines where on the chart area the axis is placed. It can only be specified in terms of a partner axis (the placement of an X-axis must be specified in a Y coordinate, and the placement of a Y-axis must be specified in an X coordinate). Therefore, if an X-axis is selected in the Axes list, only Y-axes are available in the Axis Placement list, and vice versa for the Y-axis.

1. From the Axis Placement drop-down list, select where the axis should originate. Options are Automatic, Minimum, Maximum, Value Anchored, and Origin.
2. 2.Select a partner axis from the Axes drop-down list. 
3. 3.If you selected Value Anchored, enter an integer for the starting value of the axis in the Value field. 
Note: Remember that this value corresponds to a coordinate on the partner axis, and that this coordinate should be visible on the chart area. 
[bookmark: _heading=h.147n2zr]5.3	The Annotation Tab 
The Annotation tab is composed of the different properties that are applied to the chart axis annotations, in two different tabs. The properties displayed in the Annotation tab apply to the axis currently selected in the Axes list.



5.3.1	The Annotation General Tab

The Annotation’s General tab is used to set basic properties for the chart’s annotation.

[image: ]
Figure 30	Axes properties editor – Annotation > General tab. 

The following list outlines the properties that can be set in the Annotation’s General tab:

	Procedures

	· Setting the Visible Property

	· Annotating to Range

	· Hiding Labels and Ticks for Overlapping Labels

	· Selecting a Rotation Angle

	· Selecting a font for the Axis Annoations; see Section 1.5.5, Selecting a Font.



Setting the Visible Property
The Visible check box determines whether or not the annotation is visible on the chart. To make the annotations visible, select the check box; to make them invisible, deselect it.
Annotating to Range
When, in the Annotation tab, the Method field is set to Value, the Annotate to Range property controls how the end points of the axis range are annotated. By default, the minimum value is annotated, but the rest of the annotations are automatically calculated and the maximum value may or may not be annotated.
· To annotate both ends of the axis range (the min and the max), select the Annotate to Range check box. 
Hiding Labels and Ticks for Overlapping Labels
You can specify whether labels are hidden when labels overlap. If you choose to hide labels, you can also choose whether to remove the tick marks as well.
1. To hide overlapping labels, select the Drop Overlapping Labels check box.
2. To hide the tick marks fro hidden lables, select the Drop Ticks for Hidden Labels check box.


Selecting a Rotation Angle
The rotation angle determines the angle of the annotation for the currently selected axis. The angle is always set in degrees.
· In the Annotation Rotation Angle field, use the up and down arrows to determine a value.
5.3.2	The Annotation Method Tab

The Annotation’s Method tab is used to determine the type of annotation that is used for the current axis. You can choose Point Labels, Value, Value Labels, or Time Labels from the Method drop-down list to select the annotation method. The option you choose determines what other properties you have to set. 

Note: Time labels are not supported for Polar, Radar, and Area Radar chart types; point labels are not available for any Y-axis and can only be edited through the Data View property editor’s Data tab, when the data type is Array Data. 

The following list outlines the properties that can be set in the Annotation tab:

	Procedures

	· Setting the Value Annotation Properties

	· Setting the Value Labels Annotation Properties

	· Setting the Times Labels Properties

	· Setting the Point Labels Properties



5.3.2.1	Setting the Value Annotation Properties

When the annotation is of type Value, annotation objects are used to control the drawing of ticks and labels. Each annotation object represents a series of ticks or labels, and an axis is created with a pair of default annotation objects. A user may choose to modify the properties of those default objects, set additional annotation objects on the axis, or delete existing ones. The Annotations listbox in the Annotation/Method panel displays all of the annotation objects that have been set on an axis. The controls grouped under the Annotation Attributes heading permit customization of properties for the currently selected annotation object.

[image: ]
Figure 31	Method annotation type set to Value.
Tick Mark Attributes
To customize the drawing of tick marks, select the Default Tick item in the Annotations listbox and set the following properties. Please note that for all properties except the color, it is possible to use a default value by selecting the Default check box.
1. Determine the range for the tick marks by entering the starting value in the Start field and the ending value in the Stop field.
2. Set the increment of the tick marks by entering a value in the Increment field.
3. Determine the size of the tick either by entering values or by using the up and down arrows associated with the Inner Extent and Outer Extend fields. The Inner Extent field determines how far the tick extends into the chart, while the Outer Extent field determines how far the tick extends outside of the chart.
4. Set the tick color; for more information on setting the tick color, see Section 1.5.1, Setting Colors. 
To display more than one series of tick marks on the axis, add annotation objects by clicking the + button beneath the Annotations listbox.

Label Attributes
To customize the drawing of labels, select the Default Labels item in the Annotations listbox and set the following properties. Please note that for all properties except the color, it is possible to use a default value by selecting the Default check box.
1. Set the number of decimal points for the annotation numbers either by entering a value or by using the up and down arrows associated with the Precision field.
2. Determine the extent of the label either by entering a value or by using the up and down arrows associated with the Label Extent field.
3. Set the label color; for more information on setting the tick color, see Section 1.5.1, Setting Colors.
To display more than one series of labels on the axis, add annotation objects by clicking the + button beneath the Annotations listbox.
5.3.2.2 	Setting the Value Labels Annotation Properties 

When the annotation method is of type Value Labels, labels are drawn at user-specified axis values. A value label is a label that appears at a particular axis value when the annotation type is of type Value Labels.

[image: ]
Figure 32	Method annotation type set to Value Labels.

Please note that no two value labels can have the same value. Adding a label with the same value as an existing label replaces the existing label. 

You can create labels using text strings or variables. To enter a variable, type a variable name in the Text field using the form ${KEY}, where KEY is a unique name. For more information, see “Internationalizing Your XML-based Chart” in the JClass ServerChart Programmer’s Guide. 

Whether you use text strings or variables, you can format the label using HTML. You can specify any HTML tag in the field, but only the HTML tags that are supported by JLabel are used in your chart. 

Setting the Value Labels
1. To set a value label, click the + sign below the Value Labels listbox.
2. In the Text field, type the label that you would like to display or enter a variable, using HTML tags if desired.
3. In the Value field, enter the value where the label is to appear.
Customizing the Tick Marks
When the User Default Tick Spacing check box is selected, ticks are drawn at the positions of the value labels; otherwise, they are drawn according to the attributes of the Default Ticks annotation object. It is possible to customize the Default Ticks annotations object or set additional tick objects on the axis. Please not atht for all properties except the color, it is possible to use a default value by selecting the Default check box.
1. To create a new set of tick marks, click the + sign below the Ticks table.
2. Determine the range for the tick marks by entering the starting value in the Start field and the ending value in the Stop field.
3. Set the increment of the tick marks by entering a value in the Increment field.
4. Determine the size of the tick either by entering values or by using the up and down arrows associated with the Inner Extent and Outer Extend fields. The Inner Extent field determines how far the tick extends into the plot area, while the Outer Extent field determines how far the tick extends outside of the plot area.
5. Set the tick color; for more information on setting the tick color, see Section 1.5.1, Setting Colors.
Truncating Axis Labels

You can choose whether to truncate label text when labels overlap.
1. Set the width of the label in pixels in the Max Label Width field.
2. Select how the label is to be truncated from the Truncate Mode drop-down list. Valid values are Left, Right, Center, Leading, and Trailing.


5.3.2.3	Setting the Time Labels Properties

JClass ServerChart Designer generates time labels, depending on the settings you provide when the annotation type is of type Time Labels.

[image: ]
Figure 33	Method annotation types set to Time Labels.

Setting the Time Labels
1. Using the scrolling lists, select a year and month to update the calendar.
2. Click on the start date in the calendar below.
3. Enter the time in the field below the calendar, either by typing the value or by using the corresponding up and down arrows.
Note: The time must be entered in the following format: HH:mm:ss
4. Determine the precision of the time label by selecting it from the Unit drop-down list. Options are Seconds, Minutes, Hours, Days, Months, and Years.


5. The Format value is automatically set to the default, which is dependant on the Unit. To change the Format, you must first deselect the Default check box. Next, enter the desired format in the field. Valid options are (values are case-sensitive):
	Output
	Value

	seconds
	ss

	minutes
	mm

	hours
	HH

	day
	dd

	month
	MMM

	last two digits in year
	yy

	year
	yyyy


To return to the default value at any time, select Default check box.
6. To remove weekends from a time-based axis, select Skip Weekends check box.

Customizing the Tick Marks
To use the default tick spacing properties, click the Use Default Tick Spacing check box. Please note that for all properties except the color, it is possible to use a default value by selecting the Default check box.
1. To create a new set of tick marks, click the + sign below the Ticks table.
2. Determine the range for the tick marks by entering the starting value in the Start field and the ending value in the Stop field.
3. Set the increment of the tick marks by entering a value in the Increment field.
4. Determine the size of the tick either by entering values or by using the up and down arrows associated with the Inner Extent and Outer Extend fields. The Inner Extent field determines how far the tick extends into the plot area, while the Outer Extent field determines how far the tick extends outside of the plot area.
5. Set the tick color; for more information on setting the tick color, see Section 1.5.1, Setting Colors.


5.3.2.4	Setting the Point Labels Properties
When the annotation method is Point Labels, a link to the Data View/Data editor is displayed. In the Array Data table, point labels can be entered at the desired array indices. There are no properties to set for the actual labels for point labels, though the tick properties can be customized. However, a link to the Data View editor, where point labels are set, appears if you have selected this annotation type.

[image: ]
Figure 34	Method annotation type set to Point Labels.

Customizing the Tick Marks
To use the default tick spacing properties, click the Use Default Tick Spacing check box. Please note that for all properties except the color, it is possible to use a default value by selecting the Default check box.
1. To create a new set of tick marks, click the + sign below the Ticks table.
2. Determine the range for the tick marks by entering the starting value in the Start field and the ending value in the Stop field.
3. Set the increment of the tick marks by entering a value in the Increment field.
4. Determine the size of the tick either by entering values or by using the up and down arrows associated with the Inner Extent and Outer Extend fields. The Inner Extent field determines how far the tick extends into the plot area, while the Outer Extent field determines how far the tick extends outside of the plot area.
5. Set the tick color; for more information on setting the tick color, see Section 1.5.1, Setting Colors.

Truncating Axis Labels
You can choose whether to truncate label text when labels overlap.
1. Set the width of the label in pixels in the Max Label Width field.
2. Select how the label is to be truncated from the Truncate Mode drop-down list. Valid values are Left, Right, Center, Leading, and Trailing.
[bookmark: _heading=h.3o7alnk]5.4	The Scale Tab
The Scale tab determines the size, origin, and placement of the origin for the axis selected in the Axes list.

[image: ]
Figure 35	Axes properties editor – Scale tab.

Note: To change any of the properties, you must deselect the Default check box. To return to the default value at any time, select the Default check box. 

The following list outlines the properties that can be set in the Scale tab:

	Procedures

	· Defining the Axis Minimum

	· Defining the Axis Maximum

	· Setting and Placing the Origin



5.4.1 	 Defining the Axis Minimum

The axis minimum determines the minimum value for the axis. 
· To select an axis minimum, type a value in the Axis Min field.

5.4.2 	 Defining the Axis Maximum

The axis minimum determines the maximum value for the axis. 
· To select an axis maximum, type a value in the Axis Max field.



5.4.3	Setting and Placing the Origin

The axis origin determines the start of the axis; the Scale tab has properties that set and place the origin. 

1. From the Origin Placement drop-down list, select the origin placement. Options are Automatic, Minimum, Maximum, and Zero.
2. To set the axis origin, enter a value in the Origin field.
[bookmark: _heading=h.23ckvvd]5.5	The Title Tab
A chart axis may have a title associated with it. The Title tab controls all of the properties that pertain to an axis title.

[image: ]
Figure 36	     Axes properties editor – Title tab.

The following list outlines the properties that can be set in the Title tab:


	Procedures

	· Entering the Title Text

	· Placing and Rotating the Title Text

	· Selecting a font for the title text; see Section 1.5.5, Selecting a Font.
· Setting the title text’s color; see Section 1.5.1, Setting Colors.





5.5.1	Entering the Title Text

The Text field determines the title for the chart axis selected in the Axes list. You can enter a text string or a variable. To enter a variable, type a variable name in the Text field using the form ${KEY}, where KEY is a unique name. For more information, see “Internationalizing Your
XML-based Chart” in the JClass ServerChart Programmer’s Guide.

Whether you use a text string or variable, you can format the label using HTML. To add the <HTML> tags automatically, select the Use HTML check box. While you can specify any HTML tag in the field, only the HTML tags that are supported by JLabel are used in your
chart.
· To enter the title text, type the text string or variable in the Text field, using HTML tags if desired.
5.5.2	Placing and Rotating the Title Text

JClass ServerChart Designer allows you to control the placement of the title, as well as provide it with a rotation. 

Note: To change this property, you must deselect the Default check box. To return to the default value at any time, select the Default check box. 

1. To set the title rotation, select a value from the Rotation (Degrees) drop-down list. Options are 0, 90, 180, and 270.
2. Select the placement from the Placement drop-down list. For horizontal axes, options are North and South; for vertical axes, options are Northeast, Northwest, East, West, Southeast, and Southwest.
[bookmark: _heading=h.ihv636]5.6 	The Grid Tab
The Grid tab controls the appearance of gridlines on the chart, assuming they are visible. In order to edit the properties of a grid, the Grid Showing check box must be selected. When the Default check box is selected, gridlines are drawn at the positions of the axis labels; otherwise, they are drawn according to the properties of Grid objects that have been set on the axis. Please note that for all properties except the color, you can use a default value by selecting the Default check box.
[image: ]
Figure 37	    Axes properties editor – Grid tab.

To add multiple grids to a chart, click the [image: ] button below the Grids list and add a new grid. New grids are automatically named by JClass ServerChart Designer with the name Grid #X, where X represents consecutive numbers.

The following list outlines the properties that can be set in the Grid tab:

	Procedures

	· Making the Grid Visible

	· Setting Grid Spacing

	· Defining the Gridline Style; see Section 1.5.3, Setting a Line Style.



5.6.1	Making the Grid Visible

Gridlines can be visible or invisible.
· To make gridlines visible, select the Show Grid check box.
5.6.2	Setting Grid Spacing

Grid spacing determines the distance between the gridlines on the chart. 

Note: To change this property, you must deselect the Default check box. To return to the default value at any time, select the Default check box. 

1. Determine the range for the tick marks by entering the starting value in the Start field and the ending value in the Stop field.
2. Set the increment of the tick marks by entering a value in the Increment field.


[bookmark: _heading=h.32hioqz]5.7 	The Exclusions Tab
The Exclusions tab enables you to specify periods of time during which you want to exclude data from the chart. For example, you might not care about data collected outside of business hours. You can remove that data from the graph by creating an exclusion that runs from say 4:00 p.m. (16:00:00) to 9:00 a.m. (09:30:00) the next day.

[image: ]
Figure 38     Axes properties editor – Exclusions tab

1. To create an exclusion, click the + sign below the Exclusions table.
2. By default, the exclusion is active. You can turn off the exclusion by deselecting the Active check box.
3. By default, the exclusion is a one-time only event. To create a recurring exclusions, set the Recurrence Pattern drop-down list to either Daily or Weekly. For daily exclusions, only the hour, minute, and seconds are used. For weekly exclusions, only the day of the week, hour, minute, and seconds are used.
4. In the first calendar, select the starting date of the exclusion.
5. Below the first calendar, set the starting time of the exclusion in the format hh:mm:ss. You can specify that the start time be removed from the excluded time period by selecting the Start Time Omitted check box.
6. In the second calendar, select the end date of the exclusion.
7. Below the second calendar, set the stop time of the exclusion in the format hh:mm:ss. You can specify that the stop time be removed from the excluded time period by selecting the Stop Time Omitted check box.


[bookmark: _heading=h.1hmsyys]6
The Data View Properties Editor
The General Tab   ■   The Data Tab   ■   The Axes Tab   ■   The Chart Styles TabThe Hole Styles Tab
The Outline Style Tab   ■   The Exploded Pie  Tab   ■   The Thresholds Tab   ■   The Markers Tab
The Envelopes Tab   ■   The Timeline States Tab


The different chart data views are controlled through the Data View properties editor. The editor has the following tabs: General, Data, Axes, Chart Styles, Hole Styles, Outline Style, Exploded Pie, Thresholds, Markers, Envelopes, and Timeline States. Some tabs are associated with a specific chart type and are active only when the chart type is selected. For example, timeline states are required in timeline charts only.

[image: ]
Figure 39	JClass ServerChart Designer’s Data View properties editor.

Aside from the different tabs available, there is also a Data View list on the left side of the Data View properties editor. The data view that is selected in the list is the data view that is currently being edited. 

To add a data view, click the [image: ] button; to eliminate a data view from the list, highlight it and click the [image: ] button. 

Note: There must always be at least one data view in the Data View list. When there is only one data view in the list, you cannot delete it.
[bookmark: _heading=h.41mghml]6.1 	The General Tab
The General tab allows you to edit general data view properties. Depending on which chart type you have selected, you have different properties available for editing. 

The following list outlines procedures that can be performed in the General tab:


	Procedures

	· Setting the Data View Name and Other Basic Properties

	· Generating Labels

	· Selecting a Chart Type and Defining Properties 
· Setting the Image Map; see Section 1.5.8, Setting the Image Map.


6.1.1	Setting the Data View Name and Other Basic Properties

There are several general properties to set for each data view, including the name, its visibility, the legend display properties, and the data labels display properties.

[image: ]
Figure 40    Data View editor’s General tab – Basic properties.

For the data view name, you can enter a text string or a variable. To enter a variable, type a variable name in the View Name field using the form ${KEY}, where KEY is a unique name. For more information, see “Internationalizing Your XML-based Chart” in the JClass ServerChart Programmer’s Guide. 

Whether you use a text string or variable, you can format the label using HTML. You can specify any HTML tag in the field, but only the HTML tags that are supported by JLabel are used in your chart. 



1. To set the view name, select the data view in the Data View list.
2. To define the data view name, type the text string or variable in the Name field, using HTML tags if desired.
3. To make the data view visible on the chart, select the Visible check box.
4. To make the data view visible in the legend, select the Visible in Legend check box.
5. To reverse the order of the data series in the legend, select the Legend Series Reversed check box.
6.1.1.1 	Generating Labels

Data labels are displayed in JCChartLabels at every data index in the chart. 

1. To automatically generate chart labels, select the Auto Generate Labels check box.
2. Select the contents of labels by selecting one of the following options from the Auto Label Type drop-down list: 

· Data Value – Displays the data value of the data point in a manner appropriate to the chart type. For example, in a bar chart, only y-values are displayed, whereas in a plot chart, both x- and y-values (x,y) are displayed.
· Data Labels – Displays the data labels assigned to each y-value in the data source. If you select this option and data labels are missing from the source, empty labels are drawn on the chart. 
· Generator – Specifies that you want to generate auto labels externally. You will need to set the AutoLabelGenerator property to an object that implements the JCAutoLabelGenerator interface. For more information, see the API documentation.
6.1.2	Selecting a Chart Type and Defining Properties

You can create any of the JClass ServerChart chart types in JClass ServerChart Designer. 

· In the Chart Type drop-down list, select the desired chart type. 

The properties in the General tab change to reflect the chart type selected.


	Procedures

	· Plot Chart






	Procedures

	· Area Chart

	· Stacking Area Chart

	· Bar Charts
· Stacking Bar Chart
· PieChart
· Hi-Lo-Open-Close-Chart
· Candle Chart
· Polar, Radar, and Area Radar Charts

	· Timeline Chart



Note: Scatter plot charts and Hi-Lo charts do not have any extra properties to set.

Plot Chart

[image: ]
Figure 41     Plot chart properties.

By default, JClass ServerChart draws the lines and points on a plot chart in segments. For example, JClass ServerChart uses the following algorithm: draw a line from the first point to the second point, draw a symbol at the first point, draw a line from the second point to the third point, draw a symbol at the second point, and so on until all points are plotted. This is a memory efficient way of rendering a plot chart and is the recommended algorithm. 

When you implement a dashed (or dotted) line style, the pattern of dashes restarts at each segment, which can result in an uneven dash pattern across the length of the plot line. While not usually a problem when viewing a chart on screen, the breaks in the pattern may be more obvious when the chart is printed. If you want the dashed line to have a continuous pattern through all plot points, you can choose to use the GeneralPath algorithm instead. The GeneralPath algorithm draws the entire plot line first (as a single unit) and then draws all the
data points.

Note: The GeneralPath algorithm should not be used for plots with many points as it can use significantly more memory and is somewhat slower than the default plot algorithm.

· To draw the entire plot line before plotting points, select the Use General Path Plot check box.

Area Chart

[image: ]
Figure 42	     Area chart properties.

You can specify the following information: 
· When data values in a series cross the origin, going from a positive value to a negative value or vice versa, the transition is handled in such a way that there is a region of connection between polygons above and below the origin line. This enables the polygons in a stacking area chart to stack naturally. For area charts, you can choose to cross at a single point rather than a region. To do so, select the Connected Across Origin check box.
· For the Outline Style, you can choose whether you want to use the chart’s outline style or a unique data series outline style.
· To set how holes are represented in the chart, set the Hole Interpretation field to one of the following values: 
· Absent Value – Represents holes as values that are absent from the chart. The dummy value for the hole is at the origin. 
· Interpolate Value – Draws a line from the last real value to the next real value. The hole value is assigned a dummy value that is a point between the last real value and the next real value. When the first or last value in a series is a hole, the hole is assigned a dummy value of the origin. 
· Previous Value – Assigns the hole a dummy value that is the same value as the last real value in the data series. When the first value in a series is a hole, the hole is assigned a dummy value of the origin. When the last value is a hole, it is assigned the value of the last real data value.

Tip: The results of the different hole interpretations may not be visible in the chart until you apply hole styles to the series.

Stacking Area Chart

[image: ]
Figure 43     Stacking area chart properties.

You can specify the following information:

· Select the 100 Percent check box to make each stacked area’s total Y-values represents 100%. The Y-value of each area is interpreted as its percentage of the total.
· For the Outline Style, choose whether you want to use the chart’s outline style or a unique data series outline style.
· To set how holes are represented in the chart, set the Hole Interpretation field to one of the following values: 
· Absent Value – Represents holes as values that are absent from the chart. The dummy value for the hole is at the origin. 
· Interpolate Value – Draws a line from the last real value to the next real value. The hole value is assigned a dummy value that is a point between the last real value and the next real value. When the first or last value in a series is a hole, the hole is assigned a dummy value of the origin. 
· Previous Value – Assigns the hole a dummy value that is the same value as the last real value in the data series. When the first value in a series is a hole, the hole is assigned a dummy value of the origin. When the last value is a hole, it is assigned the value of the last real data value. 

Tip: The results of the different hole interpretations may not be clear until you apply hole styles to the series.

Bar Charts

[image: ]
Figure 44	     Bar chart properties.

You can specify the following information:
· Enter the cluster width, either by typing a value or by using the up and down arrows, in the Cluster Width field. The cluster width controls the width of all of the bars in the bar cluster, as a percentage of the space available for that cluster (valid values are between 0 and 100).
· Enter the luster overlap, either by typing a value or by using the up and down arrows, in the Cluster Overlap field. The cluster overlap controls how much each bar in the cluster overlaps the one before it, as a percentage (valid values are between -100 and 100).
· For the Outline Style, choose whether you want to use the chart’s outline style or a unique data series outline style.

Stacking Bar Chart

[image: ]
Figure 45     Stacking bar chart properties.

You can specify the following information:

· Enter the cluster width, either by typing a value or by using the up and down arrows, in the Cluster Width field. The cluster width controls the width of all of the bars in the bar cluster, as a percentage of the space available for that cluster (valid values are between 0 and 100).
· Select the 100 Percent check box to make each stacked bar’s total Y-values represents 100%. The Y-value of each bar is interpreted as its percentage of the total.
· For the Outline Style, choose whether you want to use the chart’s outline style or a unique data series outline style.

Pie Chart
Pie charts have several distinct properties that can be used to customize the chart. 

Note: When editing a Pie chart, the Exploded Pie tab also becomes available for customization. To access the tab, you can click the Go to Exploded Pie Editor button, or click the tab itself. The Exploded Pie tab controls the properties for exploded pie slices. For more information, see Section 6.7, The Exploded Pie Tab. 

The General tab controls the number of slices, the position of the first slice, and the composition of the other slice.

[image: ]
Figure 46     Pie chart – General properties.

You can specify the following information in the General tab: 
· From the Threshold Method drop-down list, select one of the following values:
· Slice Cutoff – The threshold value is used as a cutoff to determine what items are lumped into the “other” slice.
· Percentile – The items are grouped into the “other” slice until it represents the percent of the pie determined in the threshold value.
· Enter the threshold value, either by typing a value or by using the up and down arrows, in the Threshold Value field.
· From the Sort Order drop-down list, determine if the data should be sorted by Data Order, Ascending values, or Descending values.
· In the Minimum Slices field, either type a value or use the up and down arrows to determine the minimum number of slices each pie chart must contain.
· In the Start Angle (Degrees) field, either type a value or use the up and down arrows to determine the angle where the first pie slice starts.

The Other Slice tab controls the name of the other slice and defines image maps.
[image: ]
Figure 47     Pie chart – Other Slice properties.

You can specify the following information in the Other Slice tab: 

· To provide a name for the “other” slice, type it in the Other Slice Label field.
· To create an Image Map for the Other slice, enter the appropriate values in the Other Slice ImageMap List section. For more information on creating Image Maps, see Section 1.5.8, Setting the Image Map.
· To create an Image Map for the Other slice’s legend, enter the appropriate values in the Other Slice Legend ImageMap section. For more information on creating Image Maps, see Section 1.5.8, Setting the Image Map. 

The Other Slice Fill Style tab specifies the fill style for the other slice. For more information, see Setting a Fill Style, in Chapter 1.



Hi-Lo-Open-Close

[image: ]
Figure 48	     Hi-Lo-Open-Close chart properties.

The Hi-Lo-Open-Close chart type allows you determine the visibility of the open and close values, as well as whether the values are the full or half width.
· To set the width of the symbol, set the Open Close Width Mode drop-down list to one of the following: 
· Pixel – Uses the tick width of the corresponding chart style for this series. 
· Percentage – Causes the hloc symbol width to be given a percentage of the available width. When selected, set the percentage in the Open Close Width field.
· To display the open values, select the Show Open check box.
· To display the close values, select the Show Close check box.
· If the open and close values should be the full width, select the Open Close Full Width check box.

Candle Chart

[image: ]
Figure 49     Candle chart properties.

Candle charts can be either simple or complex. A simple candle chart uses the chart style from only the first series in its data group to determine the appearance of the chart; a complex candle chart uses elements of the chart styles of all four series to determine its appearance.

· To set the width of the candle, set the Candle Width Mode drop-down list to one of the following: 
· Pixel – Uses the symbol width of the corresponding chart style for this series.
· Percentage – Causes the candle symbol width to be given a percentage of the available width. When selected, set the percentage in the Open Close Width field.
· To create a complex candle chart, select the Complex check box. For a simple chart, deselect the Complex check box.

Polar, Radar, and Area Radar Charts
Radar and Area Radar charts have the same properties available for customization in the JClass ServerChart Designer. Area Radar offers an additional property to set an outline style.

[image: ]
Figure 50     Radar chart properties (left) and area radar chart properties (right).

Polar charts differ only slightly from radar and area radar charts, including a half-range instead of circular gridlines.

[image: ]
Figure 51     Polar chart properties.


You can specify the following information:

· Determine the angle for the origin base either by typing a value or using the up and down arrows next to the Origin Base Angle field.
· To set the angle for the Y-axis, either type a value or use the up and down arrows next to the Y Axis Angle field.
· For Radar or Area Radar charts, select Circular Gridlines to show gridlines. 
· If you are editing a Polar chart, and would like to use half-ranges, select the Half-Range check box. If a Polar chart is set to use half-ranges, the X-axis consists of two half-ranges (-180, 0] and (0, 180] instead of one full range [0, 360).
· For Area Radar charts, you can choose an Outline Style. Choose whether you want to use the chart’s outline style or a unique data series outline style.

Timeline Chart
For the timeline chart type, the specialized properties are grouped into four tabs. See also Section 6.11, The Timeline States Tab. 

In the General tab, you can set the height of the bars. You can also navigate directly to the Timeline States editor, where you can define the states to use with this timeline chart.

[image: ]
Figure 52    Timeline chart – General properties.

· To specify how the bar height is determined, set the Bar Height Mode to one of the following: 
· Pixel – Makes the height the same as the symbol size specified in the chart style. 
· Percentage – When selected, you can set the percentage in the Percentage Height field. JClass ServerChart fits all tracks into the specified percentage of the plot area, resizing the height of the bars accordingly. For example, if the percentage height is 30, the bars will be resized so that all tracks fit in 30% of the plot area.


In the Tracks tab, you can control the behavior of tracks as a group.

[image: ]
Figure 53     Timeline chart – Track properties.


You can specify the following information: 

· If data across the tracks is sparse, you can specify that track data be merged where possible. Data that overlaps cannot be merged and remains in a separate track. To merge tracks, select the Merge Tracks check box.
· By default, tracks are listed in order from top to bottom. To order tracks from bottom to top, select the Ascending Tracks check box.
· The Layout Type field determines the layout of the timeline chart. Stepped layout is a special layout for instant events. Tracks are created to fill the available space and the instant events are added to the tracks in the order specified by the Ascending Tracks property. On adding an instant event to the last track, the layout manager cycles back to the first track. 
· To specify where the tracks are located within the plot area, set the Track Position drop-down list to Top, Center, or Bottom.
· By default, the tracks can be any height. To restrict the height, set the Max Track Height field to a specified value in pixels. The bar height properties on the General tab respect the value of this property.

The Labels tab controls the contents and placement of interval labels.
[image: ]
Figure 54     Timeline chart – Labels properties.


You can specify the following information: 
1. To specify the content of the interval labels, select one or more of the Label Data, Label Series, and Label State check boxes. If none are selected, the intervals have no labels.
2. The Label Threshold field specifies a multiplier that helps to determine whether there is space inside an interval to draw the label. The calculation is (width of the label text * multiplier + label inset). Labels that do not fit are placed after the interval.
3. To indent the label, set the Label Inset field to a value in pixels. 

The Truncate tab controls whether interval labels are truncated, and if so, the rules for truncating the content of the interval labels.

[image: ]
Figure 55     Timeline chart – properties.


You can specify the following information: 

1. To truncate interval labels, select the Truncate Labels check box.
2. To specify that an ellipsis be used to indicate missing text, select the Use Ellipsis When Truncating check box.
3. To specify which part of the text is truncated, set the Truncate Mode drop-down list. By default Trailing text is truncated. Other possible values are Left, Center, Right, and Leading.
4. To specify the maximum width constraint for the label of an instant event (zero-duration interval, represented by a symbol), set the Max Symbol Label Width field to a value in pixels.


[bookmark: _heading=h.2grqrue]6.2 	The Data Tab
The Data tab controls the data that is flowed into the chart.

	[bookmark: _heading=h.vx1227]Procedures

	· Defining the Data Series

	· Setting Data Limits

	· Defining the Chart Save Options



6.2.1	Defining the Data Series

You can define the properties, data, and data thresholds for a data series in the Data Series tab of the Data tab.

	Procedures

	· Setting Properties for a Data Series

	· Select the Data Type and Data Source

	· Specifying General Data for the Data Series
· Specifying Array Data for the Data Series
· Defining Data Thresholds for the Data Series
· Setting the Image Map; see Section 1.5.8, Setting the Image Map.




6.2.1.1 	Setting Properties for a Data Series

For each data series, you can set its name, labels, visibility, and inclusion properties, as well as specifying image maps and the data range.
[image: ]
Figure 56     Data View properties editor – Data > General tab.


1. In the Data tab, select the Data Series tab.
2. If not already displayed, select the General tab
3. Select the data series in the Series list. To add a series, click the 	[image: ]  button; to remove a series, click the [image: ] button.
4. To set the name for the data series, type a value in the Name field.
5. To define a series label, enter a String in the Label field. This label appears in the legend for this series.
6. To define a track label, enter a String in the Track Label field. This label appears on the Y-axis when a chart type supports track labels.
7. To include the series in the chart, select the Include check box. Not including a series means that the chart behaves as if the series does not exist.
8. To make the data appear, select the Visible check box. To make it appear in the legend, click the Visible in Legend check box.
9. To set Image Map information for the series, enter the values in the Series URL and Series Extra fields. To set Image Map information for the legend, enter the values in the Legend URL and Legend Extra fields. To set Image Map information for the point, enter the information in the Point section.
For more information on Image Maps, see Section 1.5.8, Setting the Image Map.
10. To define a range for the values, set a value in the First and Last fields.

Note: When the Default check box is selected for the Last field, you cannot change its value until the check box has been deselected.

6.2.1.2 	Select the Data Type and Data Source

From the Data Series tab, you can add data using in the Contents tab. You can select either General or Array data. General data allows for different X and Y coordinates for each data series, while Array data requires that each series has the same X values. You can add data in the table, use sample data, or load data from an external source.

The data source defines from where the chart receives its data.

1. In the Data Series tab, select the Contents tab.
2. Select either Array Data or General Data from the Data Type drop-down list.

Note: Switching from General data to Array data may result in loss of data.

3. To add data, do one of the following:
· To use your own data source, click the Load button and navigate to the data to use.  
· To use the ServerChart Designer’s sample data, select the Sample Data check box. 
· To specify your own data, click in a cell, type the data, and press the Enter key.
6.2.1.3 	Specifying General Data for the Data Series

General Data refers to data that consists of one or more series of X and Y pairs. The X values in one series are independent from the X values in other series.

[image: ]
Figure 57     Data View properties editor – Data > Data Series > Contents tab for General Data.


Editing the General Data Table
The table consists of a list of x-values, their corresponding y-values, and an optional data label.
1. In the Contents tab, ensure that General Data is selected as Data Type.
2. To add a data point:
· In the X column, click in a cell on an empty row and enter a value. If this is a hole value, enter Hole. 
· In the Y column, enter the y-value for this data point. If this is a hole value, enter Hole. 
· In the Data Label column, add a data label, if desired. Data labels can be displayed on the chart attached to the data index.

3. To edit data, highlight the value in the cell and enter the new value. If this is a hole value, enter Hole.
4. To remove a data point, select the row button and click [image: ] the
5. button.
6. If you would like the x-data in the table to be sorted automatically, select the AutoSort check box below the table.




Adding an Image Map to a Data Point
You can add image maps to data points. For more information on Image Maps, see Section 1.5.8, Setting the Image Map.

1. Select a cell in the row for the data point.
2. Enter the URL and Extra information for the image map.
6.2.1.4 Specifying Array Data for the Data Series

Array data is data that has a number of series for which there is only one set of X values applied to each of the different series.

[image: ]
Figure 58     Data View properties editor – Data > Data Series > Contents tab for Array data.

Editing the Array Data Table
It is important to remember that the x-values and point labels are consistent across all the series. For that reason, the x-values and their point labels are set once, and automatically replicated for all data series in the data view.

1. In the Contents tab, ensure that Array Data is selected as Data Type.
2. To add a data point:
· In the X All column, click in a cell on an empty row and enter a value. If this is a hole value, enter Hole. 
· In the Point Label column, add a label for the x-value, if desired. The point label can be displayed on the x-axis. 
· In the Y column, add the y-value for this data point. 
· In the Data Label column, add a data label, if desired. Data labels can be displayed on the chart attached to the data index.
3. To edit data, highlight the value in the cell and enter the new value. If this is a hole value, enter Hole.
4. To remove a data point, select the row button and click the [image: ] button.
5. If you would like the x-data in the table to be sorted automatically, select the AutoSort check box below the table.

Adding an Image Map to a Data Point
You can add image maps to data points and to clusters. For more information on Image Maps, see Section 1.5.8, Setting the Image Map.

1. Select a cell in the row for the data point.
2. For points, enter the URL and Extra information in the Point Image Map fields.
3. For clusters, enter the URL and Extra information in the Cluster Image Map fields.
6.2.1.5 	Defining Data Thresholds for the Data Series

Note: This feature is supported for the BAR chart type only. 

You can define data thresholds for each data series in your chart and assign fill styles to each threshold. You can also choose whether the fill style for the entire bar changes, or only the portion of the bar that falls within the threshold.

[image: ]
Figure 59     Data View properties editor – Data > Data Series > Data Thresholds tab.

To define data thresholds: 

1. In the Data Series tab, select the Data Thresholds tab.
2. Select the data series in the Series list. To add a series, click the [image: ] button below the Series list; to remove a series, click the [image: ] button.
3. To add a new data threshold, click the button [image: ] below the Data Thresholds list.
4. Type a name for the threshold in the Label field.
5. Enter the threshold values in the data threshold table. Each bar can have a different threshold value.
6. To show the data threshold label in the legend, select Visible in Legend.
7. To include the data threshold when calculating the data boundaries for the chart, select Include in Data Bounds.
8. By default, only the portion of the bar that falls within the threshold changes fill style. To update the fill for the entire bar, select Entire Value.
9. If you want to add an image map tag for the threshold label in the legend, specify the information in the URL and Extra fields.
10. To change the default fill for the data threshold, select the Fill Style tab. For more information, see Setting a Fill Style, in Chapter 1.
11. To change the default line style for the data threshold, select the Line Style tab. For more information, see Setting a Line Style, in Chapter 1.
12. If desired, repeat for the other data view series in your chart.
6.2.2	Setting Data Limits

You can specify your own data limits rather than using limits calculated from the data. 

Note: If the y-axis is a 100 percent axis, these properties are ignored.

[image: ]
Figure 60     Data View properties editor – Data > Data Limits tab.

To set data limits: 

· Y Axis Data Min Hint – You can specify the data's minimum value for this data view, rather than using the one calculated from the data. If data values fall below this value, the data values are used instead. When the axis minimum is calculated, it is guaranteed to be less than or equal to this value. The value may be precision corrected.
· Y Axis Data Max Hint – You can specify the data's maximum value for this data view, rather than using the one calculated from the data. If data values exceed this value, the data values are used instead. When the axis maximum is calculated, it is guaranteed to be greater than or equal to this value. The value may be precision corrected.


6.2.3	Defining the Chart Save Options

You can specify whether and how you want the data for the selected data view to be saved when the chart is saved.

[image: ]
Figure 61     Data View properties editor – Data > Save Options tab.

Setting the Save Type
From the Save Type drop-down list, select one of the following options:
· No Data – The data is discarded. No properties need to be set.
· Embed Data – The data is embedded in the chart’s XML file. No properties need to be set.
· Text Data File – The data is saved to a text file, either locally or externally. For more information, see the following sections.
· XML Data File – The data is saved to an XML file, either locally or externally. For more information, see the following sections.

Saving Data to a Local File
The data is saved locally to the location and file name that you specify.

1. Specify the file in the Local Save Location field either by entering the fully qualified file name or by selecting the Select button and navigating to the desired file. If the field is blank, no data is saved.
2. Select a character set from the Character Set drop-down list.

Saving Data to an External Resource
The data is saved to an external resource. The access type determines how the file name is to be interpreted. For the Relative URL, Resolving Class, and Servlet access types, you need to create a LoadServerProperties object. For more information, see Chapter 13, Using JCServerChart Factory in the JClass ServerChart Programmer’s Guide, in particular the section called “Overview of the LoadServerProperties Class.”



1. Enter a name, path, or URL for the file in the Data File Name field.
2. From the Access Type drop-down list, select one of the following options:
· Default – If the resolving ServletContext is non-null, the default access is Servlet. Otherwise, the default access is Absolute.
· Absolute – Interprets the file name as an absolute name.
· URL – Interprets the file name as a URL.
· Relative URL – Interprets the file name as a URL after adding a prefix to the
beginning of it. You specify the prefix by setting the relativeURLPrefix property of the LoadServerProperties object, or calculate it from a ServletRequest by calling setRelativeURLPrefixFromServletRequest().
· Resolving Class – Requires a resolving class Class object to load the file. The
ClassLoader of the resolving class is used to resolve the String set in the file name field through a call to getResource(filename). In the resolution process, if the String starts with “/”, it is unchanged; otherwise, the package name of the resolving Class is added to the beginning of the String, after converting “.” to “/”. You specify the resolving class by setting the ResolvingClass property of the LoadServerProperties object.
· Servlet – Uses the getResource() method of a given ServletContext to resolve the file name. The resolving ServletContext must be set on the LoadServerProperties object. 
[bookmark: _heading=h.3fwokq0]6.3 	The Axes Tab
The Axes tab allows you to determine the orientation of the X- and Y-axis for the selected data view.

[image: ]
Figure 62     Data View properties editor – Axes tab.

The Axes tab also includes the Go to X axis Properties Editor and the Go to Y Axis Properties Editor buttons, which brings up the selected axis’ property editor.

6.3.1	Determining Axis Orientation

Axes can either be non-inverted or inverted. If the axis orientation is inverted, the X-axis is vertical and the Y-axis is horizontal. 

Note: In JClass ServerChart Designer, X- and Y-axes for all chart data views work in tandem; in other words, all X-axes have the same orientation, and all Y-axes use the opposite orientation of the X-axes (resulting in all Y-axes being the same orientation). Therefore, setting the axis orientation on one chart Data View applies that setting on all axes of all data views.

1. To set the orientation, select the axis combination from the Axes list (one X- and one Y-axis).
2. Click either the Inverted or Non-inverted (default) button
[bookmark: _heading=h.1v1yuxt]6.4 	The Chart Styles Tab
The Chart Styles tab defines the different properties that apply to fill, line, and symbol styles. The style currently selected in the Styles list is the one whose properties are displayed and can be edited.
To add a style, click the [image: ] button; to remove a style, highlight the value and click the [image: ]
button.

[image: ]
Figure 63     Data View properties editor – Chart Styles tab.

The following list outlines procedures that can be performed in the Chart Styles tab:

	Procedures

	· Section 1.5.2, Setting a Fill Style

	· Section 1.5.3, Setting a Line Style
· Section 1.5.4, Setting a Symbol Style

	


[bookmark: _heading=h.4f1mdlm]6.5 	The Hole Styles Tab
Hole values are data points that are invalid or missing in the data series, or that are defined as hole values in the data source. By default, hole values are not drawn on the chart. If you want, you can choose to indicate that a hole value has occurred by specifying a hole style. A hole style is a JCChartStyle object that defines the line and fill styles to use when drawing hole values. Each data series can have a different style for holes. Hole styles are supported for plot, polar, and area charts. However, for area charts, an image map will not be generated for regions that use a hole style.


Note: If hole styles are defined for the other chart types, the hole styles are ignored.
[image: ]
Figure 64     Data View properties editor – Hole Styles tab.


The following list outlines procedures that can be performed in the Hole Styles tab:

	Procedures

	· Section 1.5.2, Setting a Fill Style

	· Section 1.5.3, Setting a Line Style
· Section 1.5.4, Setting a Symbol Style

	


[bookmark: _heading=h.2u6wntf]6.6 	The Outline Style Tab
The Outline Style tab sets the appearance for the outlines of elements in the chart, such as bars, areas, and pies. Several different properties make up the chart outline, including color, line width, line style, join, and cap. The currently defined outline is displayed in the Preview area. For more information, see Section 1.5.3, Setting a Line Style.

[image: ]
Figure 65     Data View properties editor – Outline Style tab.
[bookmark: _heading=h.19c6y18]6.7 	The Exploded Pie Tab
Note: The Exploded Pie tab is active only for PIE charts. 

The Exploded Pie tab controls which slices in a pie chart are exploded (that is, detached from the rest of the pie), as well as the properties relating to an exploded pie slice.

[image: ]
Figure 66     Data View properties editor – Exploded Pie tab.

The following list outlines procedures that can be performed in the Exploded Pie tab:

	Procedures

	· Setting the Offset

	· Determining the Exploded Slices





6.7.1	Setting the Offset

The Explode Offset field determines the space (in pixels) between the exploded pie slice and the rest of the chart. 

· To determine the offset, enter a value in the Explode Offset field.
6.7.2	Determining the Exploded Slices

JClass ServerChart Designer allows you to select which slices are exploded, and in which pies. 

1. Select a series from the Series list.
2. Do one of the following:
· To explode the series in one pie, select the check box in the Point list that corresponds to the pie.
· To explode the series in all of the pies, click the All button.
Note: Clicking the All button is not the same thing as selecting each check box individually. If you have clicked the All button, any points that are added in the future will also be exploded; if you selected each check box individually, any points that are added in the future will not be exploded.
· To explode all of the series for a specific pie, select the pie in the Points list, then select the Explode all series for the current point check box.
3. To clear all check boxes for a data series, click the None button.
[bookmark: _heading=h.3tbugp1]6.8 	The Thresholds Tab
Thresholds enable you to specify regions of different colors in the plot area of the chart. For example, you can create a red zone to indicate that the data values located within the zone are problematic in some specified way. You can use multiple thresholds in a single chart, and the thresholds can overlap. Each data view can have its own list of thresholds. Thresholds are added to the chart immediately after the plot area is drawn, and they are drawn in the order in which they appear in the threshold list for the data view. For more information including examples of how thresholds are displayed on various charts, see the Thresholds section of the “Highlighting Data Values” chapter in the JClass ServerChart Programmer’s Guide.
The Threshold tab contains controls for associating the threshold with an axis, specifying the start and end values, adding a label, showing the label in the legend, and customizing the fill color and bounding lines.

[image: ]
Figure 67     Data View properties editor – Thresholds tab.

The following list outlines procedures that can be performed in the Thresholds tab:

	Procedures

	· Creating Thresholds

	· Section 1.5.2, Setting a Fill Style 
· Adding Bounding Lines
· Deleting Thresholds

	


6.8.1	Creating Thresholds

1. Select the + button under the Thresholds list box. A threshold is added to the list and default values are assigned to some of the fields.
2. Select how the points are connected. In the Limit Type field, select Stepped or Envelope.
3. If you want to associate the threshold with the y-axis, select Associate with Y Axis (default). Otherwise, deselect it to associate the threshold with the x-axis.
4. To set where the threshold begins, select the Start Limit tab and specify the start values on the associated axis.
5. To set where the threshold ends, select the End Limit tab and specify the ending values on the associated axis.
6. Type a name for this threshold in the Label field.
7. To display the label in the legend, select Visible in Legend. Threshold labels are displayed after series labels and marker labels (if any).
8. To include the threshold values in the calculation of the data bounds, select Included in Data Bounds.
9. To use an image for the threshold in the legend, specify the image in the URL field and any extra information in the Extra field. For more information, see Section 1.5.8, Setting the Image Map.
10. To add another threshold, repeat this procedure.
6.8.2	Defining Limits with Sets of Points

If you are creating a rectangular chart, you can specify multiple points to create the start limit and the end limit. The threshold needs to be associated with the y-axis. 

1. To set where the threshold begins, select the Start Limit tab 
2. Deselect Use Constant Limit.
3. Specify the points in the table.
4. To set where the threshold ends, select the End Limit tab and repeat.

6.8.3	Adding Bounding Lines

1. Select the threshold in the Thresholds list box.
2. To display a line at the start value of the threshold, select the Start Line Style tab.
3. To change the default line style, see Section 1.5.3, Setting a Line Style. For thresholds, you need to select a different color than the color used for the fill style so that the line is visible.
4. To display a line at the end value, select the End Line Style tab and set the line style as above.
6.8.4	Deleting Thresholds

1. Select the threshold in the Thresholds list box.
2. Click the - button below the Thresholds list box.
[bookmark: _heading=h.28h4qwu]6.9 	The Markers Tab
Markers enable you to draw lines in the plot area of the chart. For example, you could create a control chart by using parallel marker lines to represent an upper limit, an average, and a lower limit. Alternatively, you could create a crosshair at a particular coordinate to highlight a target value. You can have a list of markers for each data view. For more information including examples of how markers are displayed on various charts, see the Markers section of the “Highlighting Data Values” chapter in the JClass ServerChart Programmer’s Guide.
The Markers tab contains controls for associating the marker with an axis, specifying where on the axis to draw the marker line, specifying whether the marker is drawn before or after the data, adding a label, showing the label in the legend, adding a chart label, and customizing the line length and color.

[image: ]
Figure 68     Data View properties editor – Markers tab.

The following list outlines procedures that can be performed in the Markers tab:

	Procedures

	· Creating Markers

	· Setting the Line Length and Style
· Deleting Markers



6.9.1	Creating Markers
1. Select the + button under the Markers list box. A marker is added to the list and default values are assigned to some of the fields.
2. If you want to associate the marker with the y-axis, select Associate with Y Axis (default). Otherwise, deselect it to associate the marker with the x-axis.
3. In the Value field, type the value (on the associated axis) where you want the marker line to be drawn.
4. By default, the marker will be drawn on top of the data. If you want the data to be displayed on top of the marker line, select Drawn Before Data.
5. Type a name for this marker in the Label field.
6. To display the label in the legend, select Visible in Legend. Marker labels are displayed after series labels, but before threshold labels.
7. To include the marker value in the calculation of the data bounds, select Included in Data Bounds.
8. To add a chart label to the marker, select the Chart Labels tab. For details on how to create a chart label, see Section 9.1.1, Adding and Removing Chart Labels. Note that Dwell labels are not supported.
9. To use an image for the marker in the legend, specify the image in the URL field and any extra information in the Extra field. For more information, see Section 1.5.8, Setting the Image Map.
10. To add another marker, repeat this procedure.

6.9.2	Setting the Line Length and Style

1. Select the marker in the Markers list box.
2. To change where the line starts, replace the default value in the Start Point field with the value (on the non-associated axis) where you want the marker line to start.
3. To change where the line ends, replace the default value in the End Point field with the value (on the non-associated axis) where you want the marker line to end.
4. To change the default line style, select the Line Style tab (default). For details on setting the line style, see Section 1.5.3, Setting a Line Style.

6.9.3	Deleting Markers

1. Select the marker in the Markers list box.
2. Click the - button below the Markers list box.
[bookmark: _heading=h.nmf14n]6.10	The Envelopes Tab
Note: The Envelopes tab is active only for PLOT and SCATTTER PLOT charts. 

The following list outlines procedures that can be performed in the Envelopes tab:

	Procedures

	· Creating Envelopes

	· Section 6.4, The Chart Styles Tab 
· Section 6.5, The Hole Styles Tab



[image: ]
Figure 69     Data View properties editor – Envelopes tab.



6.10.1	Creating Envelopes

1. Select the + button under the Envelopes list box. An envelope is added to the list.
2. Type a name for this envelope in the Label field.
3. To display the label in the legend, select Visible in Legend. Envelope labels are displayed at the end of the list of legend items, after series, marker, and threshold labels.
4. To include the envelope values in the calculation of the data bounds, select Included in Data Bounds.
5. To have the envelope lines drawn just before the data, select drawn with data. Otherwise is it drawn with the backplane.
6. To use an image for the envelope in the legend, specify the image in the URL field and any extra information in the Extra field. For more information, see Section 1.5.8, Setting the Image Map.
7. In the Data tab, specify an x-value in the X column and then set the upper and lower boundaries for the envelope in the Y0 and Y1 columns. Repeat for each x-value, as desired.

6.11 	The Timeline States Tab

Note: The Timeline States tab is active only for TIMELINE charts.

You need to define states for a timeline chart. States can be either integers or ranges of y-values in your data. These states will be used to determine how the status intervals and associated labels are drawn in your chart. You can also create a state that functions simply as a clear event.

[image: ]
Figure 70     Data View properties editor – Timeline States tab.



6.11.1	Defining States

1. In the Timeline States tab, select the + button under the Timeline States list box. An new state is added to the list.
2. Type a name for this state in the Label field.
3. To display the state in the legend, select the Visible in Legend check box.
4. If this state is a clear state, select the Is a Clear State check box. A clear state does not require a Chart Style because nothing is drawn on the chart while a clear state is active.
5. In the Data Ranges tab, there is one default range created. Set the minimum and maximum values for the data range. When using integers to define a range, the minimum and maximum can be the same. You can specify whether or not the end values are included in the range. If desired, you can create additional ranges for this state.
6. Select the Timeline States > Chart Style tab. For more information, see Section 6.4, The Chart Styles Tab. Note: If this is a clear state, you can skip this step.
· If you want status intervals to show as bars for this state, you can set the Fill Style to be a color, fill pattern, or image. 
· If you want status intervals to show as lines for this state, you need to set the Fill Style Pattern to None, and define a Line Style instead. 
· Select the Symbol Style tab and specify a symbol to handle instant events (events with a zero-duration status interval and shown as a symbol on the chart).
· 

[bookmark: _heading=h.37m2jsg]7
The Header and Footer Properties 
[bookmark: _heading=h.1mrcu09]Editors
Making the Header or Footer Visible■   Setting the Header or Footer Text and Alignment


The Header and Footer properties editors are identical. This section describes the properties that can be customized.

[image: ]
Figure 71     Header properties editor, which is identical to the Footer properties editor.

Note: While editing the values for these editors, make sure that the properties editor is the one currently selected in the Chart Object list.



The following list outlines procedures that can be performed in the editors:

	Procedures

	· Making the Header or Footer Visible

	· Setting the Header or Footer Text and Alignment
· Selecting the Header or Footer Font; see Section 1.5.5, Selecting a Font.
· Defining the Header or Footer Location; see Section 1.5.7, Setting the Location and Dimensions.
· Setting the Header or Footer Border; see Section 1.5.6, Setting Borders.
· Setting the Header or Footer Color; see Section 1.5.1, Setting Colors.
· Setting the Image Map; see Section 1.5.8, Setting the Image Map.


[bookmark: _heading=h.46r0co2]7.1 	Making the Header or Footer Visible
Header and Footer objects can be made visible or invisible on a chart. 

· To make the Header or Footer visible, select the Visible check box from the correct properties editor.
[bookmark: _heading=h.2lwamvv]7.2 	Setting the Header or Footer Text and Alignment
You can specify the contents of the header and footer using text strings or variables. To enter a variable, type a variable name in the Text field using the form ${KEY}, where KEY is a unique name. For more information, see “Internationalizing Your XML-based Chart” in the JClass ServerChart Programmer’s Guide. 

Whether you use text strings or variables, you can format the label using HTML. You can specify any HTML tag in the field, but only the HTML tags that are supported by JLabel are used in your chart.
1. For the header/footer, type the text string or variable in the appropriate Text field, using HTML tags if desired.
2. Use the Horizontal Position drop-down list to select a value for the text’s horizontal alignment.
3. Use the Vertical Position drop-down list to select a value for the text’s vertical alignment.


[bookmark: _heading=h.111kx3o]8
The Legend Properties Editor
General Tab   ■ Appearance Tab ■  Fill Style Tab

You can customize the default legend using the Legend properties editor.

[image: ]


[bookmark: _heading=h.3l18frh]8.1 	General Tab
The General tab contains options for setting the type of legend, its anchor point, how the contents of the legend are displayed, and image maps.
[image: ]
Figure 73     Legend properties editor – General tab.

The following list outlines the procedures that can be performed in the General tab of the editor:

	Procedures

	· Making the Legend Visible

	· Selecting a Legend Type 
· Setting the Legend’s Anchor and Orientation 
· Setting the Size of Lines and Symbols in the Legend 
· Hiding and Showing Items in the Legend 
· Adjusting the Default Width of the Legend
· Specifying How Text is Handled in the Legend
· Setting an Image Map on the Legend; see Section 1.5.8, Setting the Image Map.

	


8.1.1	Making the Legend Visible

Legends can be made visible or invisible on a chart. 

· To make the Legend visible, select the Visible check box .



8.1.2	Selecting a Legend Type

You have the option of presenting your legend in Grid or MultiColumn format. 

1. To determine the legend type, select either Grid or MultiColumn from the Legend Type drop-down list.
2. If you selected MultiColumn, specify the number of rows and columns in the Rows and Columns fields. Alternatively, select Default to have JClass ServerChart Designer design a grid that fits the data.
8.1.3	Setting the Legend’s Anchor and Orientation

The Legend requires that you set an anchor and orientation. The anchor refers to the position where the legend appears (options are North, South, East, West, Northeast, Northwest, Southeast, and Southwest); the orientation determines the direction in which the data is presented (horizontal or vertical).

· To set the legend’s anchor, select it from the Anchor drop-down list.
· To set the legend’s orientation, select it from the Orientation drop-down list.
8.1.4	Setting the Size of Lines and Symbols in the Legend

By default, the legend renders symbols and lines in a fixed size. If you want the line width and symbol size to match the values used in the chart, select Actual from the Symbol Render Mode drop-down list.
8.1.5	Hiding and Showing Items in the Legend

To control which series, markers, and/or thresholds appear in the legend, select the Data View properties editor and select the Data tab, Markers tab, or Threshold tab respectively. Select or clear the Visible in Legend check box.
8.1.6	Adjusting the Default Width of the Legend

If the legend text is very long, you may find that by default the legend becomes very wide, leaving proportionally less room for the chart itself. You can improve the balance between chart and legend by controlling the width of the legend. You have two choices for setting the width. You can set the width of the legend explicitly and allow the columns within the legend to be sized automatically, or you can set the column widths and allow the legend width to be calculated.

· To set the size of the legend, see Section 1.5.7, Setting the Location and Dimensions.
· To set the size of the columns, select the column number (or ALL) from the Column drop-down list and specify a width in the Max Item Text Width field. In the Appearance tab, select the Default check box beside the Width and Height fields.


8.1.7	Specifying How Text is Handled in the Legend

You can set properties to control what happens when the length of the text exceeds the width of a column. By default, column text is aligned with the leading edge of the column (for example, it is aligned left in a left-to-right orientation). When text is truncated, the trailing text (the rightmost text in a left-to-right orientation) is hidden and an ellipsis is displayed in its place. You can modify this behavior.
· To change the alignment, select a new alignment from the Item Text Alignment drop-down list.
· To change how the text is truncated, select the truncation policy from the Truncate Mode drop-down list.
· To hide or show the ellipsis, select or clear the Use Ellipsis When Truncating check box. This property applies to all columns.
· To display the entire legend item text in a tooltip, select the Tool Tip Enabled check box. The tooltip appears whether or not the legend text is truncated.
[bookmark: _heading=h.206ipza]8.2 	Appearance Tab
The Appearance tab contains options for setting the location and size of the legend element, border, background color, and font.

[image: ]
Figure 74     Legend properties editor – Appearance tab.

The following list outlines the procedures that can be performed in the Appearance tab of the editor:

	Procedures

	· Defining the Legend Location; see Section 1.5.7, Setting the Location and Dimensions.

	· Selecting the Legend Font; see Section 1.5.5, Selecting a Font. 
· Setting the Legend Border; see Section 1.5.6, Setting Borders. 
· Setting the Legend Color; see Section 1.5.1, Setting Colors. 
· Adding a Fill Style to the Legend; see Section 1.5.2, Setting a Fill Style. 


[bookmark: _heading=h.4k668n3]8.3 	Fill Style Tab
This tab becomes enabled when the Opaque option is selected in the Appearance tab. For more information, see Section 1.5.2, Setting a Fill Style.



[bookmark: _heading=h.2zbgiuw]9
The Chart Labels Properties Editor
The Chart Labels List   ■ The General Tab  ■  The Appearance Tab   ■  The Connected Tab

You can add and customize chart labels in the Chart Labels properties editor. The chart label that is currently selected in the Chart Labels list is the one whose properties are available for editing in the General, Appearance, and Connected tabs.

[image: ]



[bookmark: _heading=h.1egqt2p]9.1 	The Chart Labels List
The Chart Labels list contains a list of all of the chart labels that are currently available for editing in JClass ServerChart Designer.
[image: ]
Figure 76     JClass ServerChart Designer’s Chart Labels list in the Chart Labels properties editor.
9.1.1	Adding and Removing Chart Labels

You can add and remove chart labels using the Chart Labels list. 
· To add a chart label, click the [image: ] button.
· To remove a chart label, select it in the Chart Labels list and click the [image: ] button.
[bookmark: _heading=h.3ygebqi]9.2 	The General Tab
The General tab allows you to set basic chart label properties, like the type of label, the attachment, the anchor, and the actual chart label text.

[image: ]
Figure 77     Chart Labels properties editor – General tab.
The following procedures can be performed from the Chart Labels properties editor’s General tab:

	Procedures

	· Setting the Label Text and Alignment

	· Determining the Chart Label’s Basic Attributes
· Selecting an Anchor
· Setting the Attachment
· Setting the Offset
· Adjusting the Default Width of the Legend
· Setting the Image Map; see Section 1.5.8, Setting the Image Map.


9.2.1	Setting the Label Text and Alignment

The Text values are set automatically to the default. To change any of the properties, you must first deselect the Default check box. To return to the default value at any time, select the Default check box. The default value depends on the chart type and the attachment type that you have selected. It is one of the following: Y or (X, Y), where X and Y represent the coordinates of the attachment. 

You can create labels for your chart using text strings or variables. To enter a variable, type the variable name in the Text field using the form ${KEY}, where KEY is a unique name. For more information, see “Internationalizing Your XML-based Chart” in the JClass ServerChart Programmer’s Guide. 

Whether you use text strings or variables, you can format the label using HTML. To add the <HTML> tags automatically, select the Use HTML check box. While you can specify any HTML tag in the field, only the HTML tags that are supported by JLabel are used in your chart.

1. To create a label, type the text string or variable in the Text field, using HTML tags if desired.
2. Use the Horizontal Position drop-down list to select a value for the text’s horizontal alignment.
3. Use the Vertical Position drop-down list to select a value for the text’s vertical alignment.
9.2.1	Setting the Label Text and Alignment

To determine the chart label type, select the appropriate check boxes: 

· For a dwell label, select the Dwell Label check box. A dwell label is a label that pops up when the mouse pointer moves over its attachment point.
· For a visible label, select the Visible check box.
9.2.3	Selecting an Anchor

The anchor determines which part of the label is attached to the chart. 

· To set the anchor property, select a value from the Anchor drop-down list.
9.2.4	Setting the Attachment

Chart labels can have no attachment, or they can be attached to a specific point on the chart. When attaching a label to a specific point, you can select from pixel coordinates, data coordinates, or data indexes.

To set the attachment point, select one of the options from the Attachment list. 

· No Attachment – There are no properties to set.
· Attach to Coordinate – Set the coordinates in the X and Y fields.
· Attach to Data Coordinate – Select the data view from the Data View drop-down list. Next, set the floating point number by entering values in the X and Y fields. If your label does not appear on the chart, check that the values you set fall within the bounds of the chart.
· Attach to Data Index – Select a data view from the Data View drop-down list, and a corresponding series from the Series drop-down list. Next, set the point that the label attaches itself to in the Point field. The value in the Point field corresponds to a point index within the series, not to a coordinate.

For bar, stacking bar, and pie charts, you can also select where the label is positioned within the bar or slice using the Attach Mode drop-down list. The position of the label for each selection is summarized in the following table.

	Attach Mode
	Label on a Bar
	Label on a Stacking Bar
	Label on a Pie Slice

	Default
	top of bar
	center of bar
	midpoint of slice, on the circumference

	Minor
	bottom of bar
	left of bar
	midpoint of slice, along the inside of the circumference

	Center
	center of bar
	center of bar
	midpoint of slice, on the circumference

	Major
	top of bar
	right of bar
	midpoint of slice, outside the circumference



Note: For Bar or Stacking Bar charts, if the chart is inverted or the axes are reversed, the attach positions will change depending on which direction the bars are facing.



9.2.5	Setting the Offset

Offset specifies the offset from where the label is attached to the chart to where the label is drawn. It is often used with connected labels to allow room for a connected line between the label and the attachment point.

· To set the offset, set the coordinates either by entering a value or by using the up and down arrows for the X and Y fields.
[bookmark: _heading=h.2dlolyb]9.3 	The Appearance Tab
The Appearance tab allows you to specify formatting for the chart label text. The chart label currently selected in the Chart Labels list is the one to which your changes are applied.

[image: ]
Figure 78     Chart Labels properties editor’s Appearance tab.

Instructions for setting the properties in the Appearance tab are described in Common JClass ServerChart Designer Procedures, in Chapter 1. The following procedures are those that can be performed in the Appearance tab:

	Procedures

	· Selecting a Font for the Label; see Section 1.5.5, Selecting a Font.

	· Setting the Label’s Color; see Section 1.5.1, Setting Colors. 
· Setting a Border for a Label; see Section 1.5.6, Setting Borders. 



Note: The Location information is for reference purposes only, and thus is read-only. Therefore, none of the Location values can be set from this tab. Please note that the chart label’s X and Y values are determined by the attachment; for more information on setting attachments, see Section 9.2.4, Setting the Attachment.

[bookmark: _heading=h.sqyw64]9.4 	The Connected Tab
You can add a line to connect the label to its associated location on the chart. You can specify the line style and the place where that line connects to the label.

[image: ]
Figure 79     Chart Labels properties editor’s Connected tab.


	Procedures

	· Adding Connecting Lines

	· Selecting a Line Style; see Section 1.5.3, Setting a Line Style.



9.4.1	Adding Connecting Lines

When you add a connecting line, the line connects to the side of the label closest to the point. By default, it is attached to the midpoint of that side. You can link to a corner of the label instead. 

1. To add connecting lines, select the Connected check box.
2. Select the place where the line attaches to the label from the Connected Attach Mode drop-down list.
· Center (default) – Attaches the line to the midpoint of the side of the chart label.
· Minimum – When a line connects to the top or bottom of a label, the line is attached to the left corner of that side. When a line connects to the left or right side of the label, the line is attached to the bottom corner of that side. 
· Maximum – When a line connects to the top or bottom of a label, the line is attached to the right corner of that side. When a line connects to the left or right side of the label, the line is attached to the top corner of that side.


[bookmark: _heading=h.3cqmetx]10
The Image Map Rules Properties Editor
The Image Map Rules List■ Setting Image Map Rule Properties


The Image Map Rules properties editor determines the image map rules that are applied to any image maps that are automatically created when the chart is generated.

[image: ]
Figure 80     JClass ServerChart Designer’s Image Map Rules properties editor.



[bookmark: _heading=h.1rvwp1q]10.1 	The Image Map Rules List
The Image Map Rules list provides a list of all of the image map rules that are currently available for editing in JClass ServerChart Designer.
[image: ]
Figure 81     Image Map Rules list in the Image Map Rules properties editor.

The image map rule that is currently selected in the list is the one whose properties are available for editing.
10.1.1	Adding and Removing Image Map Rules

JClass ServerChart Designer allows you to add or remove image map rules from the list, thus adding or removing them from availability when automatically generating image maps. 

■To add an image map rule, click the [image: ] button; to eliminate an image map rules, highlight it in the list and click the [image: ] button.
[bookmark: _heading=h.4bvk7pj]10.2 	Setting Image Setting the Legend Properties Rule Properties
The following procedures can be performed from the Image Map Rules properties editor:


	Procedures

	· Setting the Data Properties

	· Setting the Legend Properties





10.2.1	Setting the Data Properties

The data properties determine the chart type that the rule can be applied to, the method used to apply it, the data view, and several other properties of the image map rule.

1. To set the image map type, select it from the Type drop-down list. Options include Point, Cluster, and Series.
2. Determine the method to use on the image maps by selecting it from the Method drop-down list.
3. Select the data view to apply the current image map rules to in the Data view drop-down list.
4. If the rules should apply to a specific series or point, enter the value in either the Series or Point field. If the rule should apply to all of the series and points, select the All check box.If you are generating a pie chart, select the Other Slice check box to apply the rule to the other slice.
5. Determine the radius of the image map by entering a value in the Plot Radius field.
10.2.2	Setting the Legend Properties

The legend image map rules can be included or excluded; to include them in the image map rule, select the Include Legend Image Map Rules check box. To determine the rules that apply to the legend: 

1. Select the data view to apply the current image map rules to in the Data view drop-down list.
2. If the rules should apply to a specific series, enter the value in the Series field. If the rule should apply to all series, select the All check box.
3. If you are generating a pie chart, select the Other Slice check box to apply the rule to the other slice.
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